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How to : 

Basic manipulation : 
 Rotate the planet : Click and drag on the planet with the left mouse button. 

 Rotate the background/light : Click and drag on the background with the left mouse button. 

 Translate/Pan the planet : Click and drag on the planet with the right mouse button. 

 Zoom : Click and drag the planet with the middle mouse button 

 Change the FOV (field of view) of the camera : Ctrl-left mouse button. 

These controls can be redefined in Edit->Options->Customize. There are 4 presets matching the usual 

controls of Maya, 3DS  max, Blender and Grand Designer 

Presets usage :  
Presets are stored in preset files; you can store several presets per file, overwrite them and reload 

them at will. The last preset file is automatically reopened on the next session. 

 

To manage presets files, use the File menu and the buttons located in the top panel of the 

application. Here are the functions of these elements :  

 (1) The current preset file. You can change it by creating or loading a preset file in the 

File menu. 

 File menu entries that handle preset files 

o New preset : Create a new preset file and make it active. 

o Load preset : Load an existing preset file and make it active, they can be 

located where you want. 

o Save preset as : Save the current preset file under a different name and make it 

active. 

 The dropdown menu that shows all presets available in the current file (2). Chose any 

of these presets to load it.  

 The name of the last loaded or saved preset. If you press enter in this text box, this will 

save (and eventually overwrite) the preset with that name. It has the same effect as the 

+ button (6). 

 (4) Reset all parameters to their default values, like the starting state of the software. 

 (5) Force the reload of the current preset. 

 (6) Save or update the current preset. If the name in (3) is not yet in the list (2), it will 

add it to the list, if the name is present, the preset will be updated. 

 (7) Delete the preset (3) from the list (2). This will not modify any parameters, so, you 

can always save it under another name after that.  



Use the toolbox:  

 

1. Generate in high definition: This regenerate the current preset in higher 

quality/resolution. You can modify the resolution in Edit->Options->Render size and 

the quality in Edit->Options->Render size.  

2. Take a snapshot of the scene … either a regular one, a large one or increment and 

save. The action can be defined in Edit->Options->Output->Snapshot icon.Before 

doing an increment and save, you need to take a snapshot using Edit->Snapshot or 

Ediit->Large snapshot that will define the base name of the snapshotfile as well as the 

resolution.  

3. Export the texture/model. This will open an export dialog where you can chose your 

export preset (Unreal/Unity/ PBR … ) and some other options. You can modify your 

export presets in Edit-> Options->Channels. 

4. Change the background rotation mode. This toggles between 3 modes : 

a. Stars and sun are moving together. 

b. Stars are moving, sun is fixed. 

c. Sun is moving, stars are fixed. 

5. Toggle the visibility of the planet  axis. 

6. Toggle the isolation mode. In planet mode, this toggles the visibility of the 

background, in background mode it toggles the visibility of the planet. 

7. Toggle the automatic rotation of the planet. 

8. Toggle the automatic rotation of the background. 

9. Toggle the mixer/animation module. 

10. Toggle the randomizer module. 

11. Undo button (Ctrl-Z) 

12. Redo button (Ctrl-Y) 



 

Change the options:  

 

Miscellaneous 

 Planet update : refresh mode of the planet. If you have a slow graphic card, or if you 

want to have a quick reaction time, small steps will refresh the planets small regions 

by small regions, starting from the center of the planet. If you have a super fast 

graphic card, you can disable the progressive update to refresh the complete texture in 

one go. The other options are just intermediate between the two. 

 Background update : same as planet update for the background. 

 Clouds update : same as planet update for the clouds. 

 VSync mode : Change the vertical sync settings : Every V-blank will limit the update 

to 50-60fps, Every second blank will limite the update to 25-30 fps, and freerun will 

update as fast as it can (which will increase the load on your graphic card). 

 Startup monitor : When using a multi monitor setup, defines on which monitor you’d 

like to open Grand  Designer by default. 

 GPU load : control the load of your GPU … if the load is too high for your GPU, your 

driver may crash and restart (This is an automatic feature of windows 10 to avoid GPU 

stalling). 

 Planet rotation speed : rotation speed used when in automatic rotation mode (see 

Toolbox-7) 

 Background rotation speed : rotation speed used when in automatic rotation mode (see 

Toolbox-8) 

 Start maximized : When launching the application, chose between the 

maximized/windowed mode. 



 

Customize 

 Enable tooltips : Allow the poping of tooltips on the interface to help you while using 

the software. 

 Mouse sensitivity : Mouse speed when dragging 

 Zoom sensitivity : Mousewheel speed used when zooming 

 Mouse configuration : Defines your mouse configuration. 

o Maya/3DSMax/Blender/Default : sets the configuration to one of these presets. 

 

Output 

 Preview size : This is the size at which the texture is redrawn dynamically as soon as a 

parameter is updated.  

 Render size : This is the size of high quality textures used for export, the one used 

when you regenerate your textures. Be aware that you are limited to 4k x 2k is you 

don’t have the pro extension (DLC). 



 Render AA : This is the antialiasing level of your regenerated textures. This allows 

you to regenerate your textures with a given supersampling level. The higher the 

antialiasing, the better is your texture, but the longer it takes to regenerate it. Be aware 

that you are limited to 4x supersampling if you don’t have the pro extension. 

 Internal accuracy (pro version only) : This allows you to improve the quality of 

generated textures by using 32 bits per components internally. Be carefull, because 

this will use twice as much VRAM, so, do this only on high end video cards. 

 Large snapshot : Defines the scale of the snapshots when triggering a Large one. The 

number is the size of the snapshot based on the resolution of the viewport (window 

size). 

 Snapshot icon : Defines the action of the snapshot icon (snapshot, large snapshot or 

increment and save) 

 Generate mipmaps : Enable this to enforce the generation of the mipmaps, this will use 

a bit more memory (+33%), but this increases the rendering quality and speed. 

 

Channels 

The channels output dropdown allows you to select one of the preset available, like PBR, 

Full, Unity or Unreal. You have also 3 custom presets for your own usage. Be careful, as all 

the presets can be modified. 

Every line under the dropdown menu matches a file you can export. The parameters are 

splitted like this :  

 Use : Check this checkbox if you want to activate that line. Some lines are 

automatically deactivated if the texture set is not used (like clouds or ring …) 

 RGB Channels : select the data you want to set in the color of your texture. 

 A Channel : select the data you want to set in the alpha of your texture. 

 sRGB : if checked, the color is stored in sRGB format, otherwise it is stored in linear 

format (recommended for 16bits per component modes.) 

 16 bits : only available in the pro version, if checked, the data are store with a 

precision of 16bits per component. 

 Name : the postfix added at the end of the name of your export. 



Use layer modes: 

 

 Material : Full lit material. 

 Albedo : Albedo (base color layer) 

 Roughness : Roughness of the planet 

 Height : Height of the terrain. White represent the highest portions of the terrain and black 

the lowest. 

 Height+ : Height of the terrain, color coded 

 Normal : normal maps in tangent space. 

 AO : Ambient occlusion 

 Curvature : Curvature of the terrain 

 Slope : Slope of the terrain. 

 Water : Water color 

 Moisture : Moisture level (depends on the water and settings from the weather tab) 

 Heat : Color coded heat (depends on the altitude and settings from the weather tab) 

 Clouds : Clouds layer. 

 

 



Tune color ramps: 

 

Once you click on a color ramp parameter, you can edit it on the right part of the screen. 

1. If you select this mode, you edit the complete ramp at once, RGB ou HSV are offsets 

from the original colors. 

2. In this mode, you can edit the first, second or third color independently. 

3. In this third mode, you edit the first and last color, the central one is automatically 

interpolated. 

4. You can edit your colors either in RGB or in HSV mode. 

5. You can enter the hex value of your color directly here. You have to be in mode 2 or 3 

to do that. 

6. Theses sliders allows you to change the transitions between colors. The first slider 

modifies the smoothness  of the transitions and the second slider the distance between 

the colors. 

7. Flip ramp swap the first and third color. Drag the eyedropper anywhere on the screen 

to pick the color from a reference picture easily. 

8. You can add a new color preset by typing its name in the edit box and clicking the + 

icon (or pressing the return key). The ‘A’ icon is used to see all color presets, not only 

the one of your current tab. 

9. These are the color presets you can recall by clicking them. They can be deleted by 

clicking the dustbin icon. 

 

  



Use the randomizer: 

 
The randomizer allows you to modify randomly a selected set of parameters. 

1. Click this button to randomize. 

2. Toggles the randomization of the basic parameters. 

3. Toggles the randomization of the advanced parameters. 

4. Toggles the randomization of the colors. 

5. Toggles the randomization of all parameters, not only the ones of the current section. 

6. Intensity of the randomization. 

Use the mixer/Animator: 

 

The mixer allows you to interpolate between two presets. This is very useful to :  

 Animate a scene, as this can also interpolate the position/orientation of the planet, camera, 

background and light. 

 Finetune one or more parameters. 

 Blend between two presets. 

1. This button sets the start preset key. 

2. This second button sets the end preset key. 

3. This sliders allows yoou to blend between the start and end key. 

4. This button starts the animation from beginning to end, using the current settings. If Save 

snaphots is toggled, a save dialog will open to define the base filename of the animation and 

the animation will be recorded. Hold the ESC key at any time to cancel the animation. 

5. Resolution of the renders in window size units. 

6. Number of frames to generate for the animation. 

7. Interpolation mode for the animation. This is linear by default, but you can smooth out the 

beginning, the end or both. 

8. Advanced parameters :  

a. Camera/Lights : toggles the animation of camera, lights and  background. 

b. Parameters : toggles the animation of parameters (if you just want to make a camera 

movement for instance) 

c. HD : force the rebuild in HD at every frames if the core parameters are modified 

somehow. 

d. Display interface : render the interface while doing the snapshot. May be useful for 

tutorials. 

e. Save snapshots : Save a snapshot of every frames rendered. Yoou can then make a 

movie out of it with software like Adobe Premiere. 



All parameters descriptions : 
 

Planet parameters  

Global  

 X translation : Float value between -10 and 10, X translation of the noise generators. 

 Y translation : Float value between -10 and 10, Y translation of the noise generators.. 

 Z translation : Float value between -10 and 10, Z translation of the noise generators.. 

 X rotation : Float value between -180 and 180, X rotation of the noise generators. 

 Y rotation : Float value between -180 and 180, Y rotation of the noise generators.. 

 Z rotation : Float value between -180 and 180, Z rotation of the noise generators.. 

 X scale : Float value between 0.5 and 2, X scaling of the noise generators. 

 Y scale : Float value between 0.5 and 2, Y scaling of the noise generators.. 

 Z scale : Float value between 0.5 and 2, Z scaling of the noise generators.. 

 Coverage percentage : Float value between 0.01 and 1, Percentage of the covered 

ground area. 

 Mesh density : Float value between 0.25 and 2, Density of polygons on the mesh. 

 Flatenning : Float value between 0 and 1, Flatenning of the partial mesh (works only 

on small sections). 

 Latitude offset : Float value between -1 and 1, Latitude offset of the covered ground 

area. 

 Longitude offset : Float value between -1 and 1, Longitude offset of the covered 

ground area. 

 Stand upright : On/Off value, Force the partial terrain to face up. 

Relief  

 Relief base : Filename value, Height file defining the base altitude of the planet. 

 Use inputmap : On/Off value, Use an external basemap. 

 Blur radius : Float value between 0 and 1, Blur radius of the texture (this may help 

removing unwanted glitches). 

 Input scale : Float value between -1 and 1, Input height scale. 

 Jitter level : Float value between 0 and 4, Jitter added to heightmap to add a 

grain/randomness to the planet. 

 Additionnal noise scale : Float value between -1 and 1, Scale of the regular noise 

that will be either added (positive values) or substracted (negative values). 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 

 Seed : Float value between 0 and 1, Seed used for random generation. 



 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 

 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Height curve : Curve remapping the height of the terrain. 

 Shelf level : Float value between 0 and 1, Continental shelf altitude. 

 Flattening intensity : Float value between 0 and 1, Continental shelf intensity. 

 Randomization intensity : Float value between 0 and 1, Continental shelf 

randomization. 

 Randomization scale : Float value between 0.01 and 8, Continental shelf 

randomization scale. 

 Randomization seed : Float value between 0 and 1, Continental shelf randomization 

seed. 

 Randomization balance : Float value between -0.15 and 0.15, Continental shelf 

randomization balance between regular relief and continental shelf. 

 Mountains : Color ramp with ramp shape control, Mountains colors, starting from 

valleys going to mountains. 

 Mountains in desert : Color ramp with ramp shape control, Mountains colors in 

desertic area, starting from valleys going to mountains. 

 Color bias : Float value between -0.6 and 0.6, Color ramp bias. 

 Color from slope : Float value between 0 and 1, Color from slope instead of color 

from height. 

 Underwater : Color ramp with ramp shape control, Underwater colors, starting from 

depth going to water level. 

 Color bias : Float value between -0.6 and 0.6, Underwater color ramp bias. 

 Underwater darkening : Float value between 0 and 3, Darkening of the underwater 

colors depending on the depth. 

 Land roughness : Float value between 0 and 1, Roughness of the main land 

(specularity). 

 ao roughness : Float value between -1 and 1, Roughness increase where there is AO. 

Details  
 Have details : On/Off value, Activate the details layer. 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 



 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Details height curve : Curve remapping the height of the details on the terrain. 

 Blending type : Integer value between 0 and 6, Define the blending type of the detail 

layer. 

 Level : Float value between 0 and 1, Reference level before intensity amplification. 

 Intensity : Float value between 0 and 1.5, Strength of the detail layer. 

 Cut range : Range of values, Defines the range of altitude where the details are 

applied. 

 Cut softness : Float value between 0 and 1, Transition ramp used to blend the details 

on the relief. 

 Color intensity : Float value between 0 and 10, Strength of the details coloring. 

 Detail color : Color ramp with ramp shape control, Details colors. 

 Color burn : Float value between 0 and 5, Intensity of the details coloring. 

Craters  

 Have craters : On/Off value, Activate the craters layer. 

 Seed : Float value between 0 and 1, Seed used to generate craters positions. 

 Craters count : Integer value between 0 and 500, Number of craters on the planet. 

 Minimal radius : Float value between 0.001 and 0.25, Minimal radius of the craters. 

 Maximal radius extend : Float value between 0 and 1, Maximal radius of the craters. 

 Random radius distribution : Float value between 0 and 1, Balance the distribution 

of small and large craters. 

 Height : Float value between 0.05 and 2, Height of the crater's border. 

 Height attenuation : Float value between 0 and 1, Attenuate the height of smaller 

craters. 

 Depth : Float value between -2 and 1, Depth of the inner part of the crater. 

 Depth shape : Float value between 0 and 1, Shape of the inner part of the crater. 

 Blending shape : Float value between 0 and 2, Shape of the outer part of the crater. 

 Minimal age : Float value between 0.01 and 1, Minimal age of the craters. 

 Maximal age extend : Float value between 0 and 1, Maximal age of the craters. 

 Age size link : Float value between 0 and 1, Increase the age of the larger craters. 

 Roundness regularity : Float value between 0 and 1, Regularity of the crater's 

border. 

 Height depth regularity : Float value between 0 and 1, Regularity of the crater's 

height and depth. 

 Trails intensity : Float value between -0.1 and 0.5, Intensity of the explosion trails. 

 Trails limit : Float value between 0 and 1, Minimal size required to have explosion 

trails. 

 Trails density : Float value between 0 and 1, Density of trails around the crater. 

 Trails thickness : Float value between 0 and 1, Thickness of the trails around the 

crater. 

 Trails length : Float value between 0 and 1, Maximal length of the explosion trails. 

 Trails chaos : Float value between 0 and 2.5, Irregularity of the trails. 



 Secondary trails length : Float value between 0 and 4, Maximal length of the 

explosion trails. 

 Trails spreading : Float value between 0 and 1.5, Irregularity of the length of trails. 

 Inner color : Color ramp with ramp shape control, Craters colors. 

 Color burn : Float value between 0 and 5, Intensity of the craters coloring. 

 Color smoothness : Float value between 0 and 2, Smoothness of the transitions in 

craters coloring. 

Other  

 Low frequencies : Float value between 0 and 5, Weight of the low frequencies (large 

details) in the AO. 

 Medium frequencies : Float value between 0 and 5, Weight of the medium 

frequencies (average details) in the AO. 

 High frequencies : Float value between 0 and 5, Weight of the high frequencies 

(small details) in the AO. 

 AO in diffuse : Float value between 0 and 1.5, AO presence in the Albedo. 

 AO quality : Float value between 0 and 1, Quality of the AO computation, higher 

value means more samples. 

 AO curve : Curve remapping the ambient occlusion. 

 AO in water : Float value between 0 and 1, Intensity of the AO in the water. 

 AO tinting : Float value between 0 and 1, Color tinting of the AO, 0=default grey 

ramp, 1=full color ramp. 

 AO colors : Color ramp with ramp shape control, AO color ramp (if tinting is higher 

than 0). 

 Color bias : Float value between -0.6 and 0.6, Color ramp bias of the AO. 

 Ground normals : Float value between 0 and 5, Intensity of the land normal map. 

 Curvature colors : Color ramp with ramp shape control, Color scheme of the coloring 

of sharp edges. 

 Curvature coloring : Float value between 0 and 10, Coloring intensity of sharp edges. 

 Curvature coloring spread : Float value between 0 and 1, Spreading og sharp eddges 

coloring. 

Water  
 Have water : On/Off value, Activate the water layer. 

 Water level : Float value between 0 and 0.99, Height of the water level. 

 Water density : Float value between 0 and 1, Density of the water. 

 Water sharpness : Float value between 0 and 1, Sharpen the water coast. 

 Water global translucency : Float value between 0 and 1, Translucency of the water 

which allow simulation of disappeared oceans. 

 Occlusion in water : Float value between 0 and 1, Ambient occlusion in shallow 

water. 

 Baked in height : On/Off value, Bake the water height in the heightmap. 

 Water : Color ramp with ramp shape control, Water color ramp. 

 Hot water : Color ramp with ramp shape control, Water color ramp. 



 Hot color bias : Float value between -1 and 1, Offset of the color range used for the 

water 

 Color bias : Float value between -0.6 and 0.6, Water color ramp bias. 

 Water roughness : Float value between 0 and 1, Roughness of the water. 

Weather  

 Intensity : Float value between 0 and 2, Weight of the moisture coming from the 

water. 

 Spreading : Float value between 0 and 1, Spreading of the moisture from the water. 

 Temperature : Float value between -1.5 and 1.5, Intensity (positive or negative) of 

the moisture at the poles. 

 Spreading : Float value between 0 and 1.5, Area spread of the moisture at the poles. 

 Temperature : Float value between -1.5 and 1.5, Intensity (positive or negative) of 

the moisture on the equator. 

 Spreading : Float value between 0 and 1.5, Area spread of the moisture on the 

equator. 

 Temperature : Float value between -1.5 and 1.5, Intensity (positive or negative) of 

the moisture on the equator. 

 Limit : Float value between 0 and 1, Height reference for the heat drop. 

 Spreading : Float value between 0 and 1, Area spread of the moisture on the 

equator. 

 Temperature : Float value between -1 and 1, Intensity (positive or negative) of the 

moisture on the equator. 

 Spreading : Float value between 0 and 1, Area spread of the moisture on the 

equator. 

 Spread center : Float value between -0.5 and 0.5, Center of the moisture spread. 

 Goldilocks offset : Float value between -1.5 and 1.5, Global temperature offset (can 

be considered as the distance to the sun). 

 Tilt axis : Float value between -0.5 and 0.5, Tilting of the planet axis. 

 Random strength : Float value between 0 and 2.5, Randomization of the shape of 

the moisture/temperature. 

 Random scale : Float value between 0.25 and 5, Scale of the randomization of the 

moisture/temperature. 

 Random seed : Float value between 0 and 1, Randomization seed for the shape of 

the moisture/temperature. 

Ice caps  

 Have ice caps : On/Off value, Activate the ice caps layer. 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 



 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 

 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Inverted : On/Off value, Invert the noise result (valleys <-> mountains). 

 Ice expansion : Float value between 0 and 1, Ice coverage, starting from the poles. 

 Ice shape sharpness : Float value between 0 and 1, Sharpness of the ice limit. 

 Ice shape randomness : Float value between 0 and 1, Randomization of the ice limit. 

 Ice min and max : Range of values, Defines the minimal and maximal level of snow. 

 Slope influence : Float value between 0 and 0.9, Slope of mountains influence on ice 

and snow positionning (0=slope is ignored, higher=slope is driving snow placement). 

 Ice color : Color ramp with ramp shape control, Ice color ramp. 

 Color bias : Float value between -0.6 and 0.6, Ice color ramp bias. 

 Color from slope : Float value between 0 and 1, Select ice color from slope or from 

AO. 

 Ice roughness : Float value between 0 and 1, Roughness of the ice caps (specularity). 

Desert  

 Have desertic zone : On/Off value, Activate the desrtic zone. 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 

 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Inverted : On/Off value, Invert the noise result (valleys <-> mountains). 

 Desert expansion : Float value between 0 and 1, Desert coverage, starting from the 

equator. 

 Desert shape sharpness : Float value between 0 and 1, Sharpness of the desert limit. 

 Desert shape randomness : Float value between 0 and 1, Randomization of the 

desert limit. 

 Desert min and max : Range of values, Defines the minimal and maximal level of 

snow. 

 Slope influence : Float value between 0 and 0.9, Slope of mountains influence on 

desert positionning (0=slope is ignored, higher=slope is driving snow placement). 



Sediment  

 Have sediment : On/Off value, Activate the sediment layer. 

 Erosion blend : Float value between 0.5 and 5, Blending level of the sediments. 

 Sediment in cavities : Float value between 0 and 1, Amplify the amount of sediment 

in cavities. 

 Sediment on slopes : Float value between 0 and 1, Filter sediment if the slope is too 

steep. 

 Sediment by height : Range of values, Define the min and max value of the fade 

range of the sediment in conjunction with altitude. 

 Moisture select : Float value between 0 and 1, Sediment color selected from 

moisture. 

 Color bias : Float value between -0.6 and 0.6, Sediment color ramp bias. 

 Sediments on secondary : Float value between 0 and 1, Sediment color on secondary 

soil. 

Vegetation  

 Have vegetation : On/Off value, Vegetation rendering. 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 

 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Inverted : On/Off value, Invert the noise result (valleys <-> mountains). 

 Grow outside sediment : Float value between 0 and 1, Allow the vegetation to grow 

outside the sediment soil. 

 Blending : Float value between 0 and 1, Blending level of the vegetation. 

 Growth by slopes : Range of values, Defines the minimal and maximal slopes where 

vegetation is growing. 

 Growth by height : Range of values, Define the min and max value of the fade range 

of the sediment in conjunction with altitude. 

 Color bias : Float value between -0.6 and 0.6, Vegetation color ramp bias. 

 Moisture select : Float value between 0 and 1, Vegetation color selected from 

moisture. 

Rings  
 Have ring : On/Off value, Rendering of the ring around the planet. 

 Ring separation : Float value between 0 and 2, Distance from the planet to the ring. 



 Ring width : Float value between 0.1 and 10, Width of the ring. 

 Ring tilt : Float value between -90 and 90, Tilt of the ring. 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 

 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Inverted : On/Off value, Invert the noise result (valleys <-> mountains). 

 Rings : Color ramp with ramp shape control, Rings color range. 

 Color bias : Float value between -0.6 and 0.6, Color ramp bias. 

 Alpha black point : Float value between 0 and 1, Black point of the ring alpha : sets 

the minimal value used in the height field. 

 Alpha white point : Float value between 0 and 1, White point of the ring alpha : sets 

the maximal value used in the height field. 

 Micro noise color : Float value between 0 and 1, white noise in rings. 

 Micro noise alpha : Float value between 0 and 1, white noise in rings translucency. 

 Inner fade ramp : Float value between 0.01 and 1.5, Alpha ramp on the inside of the 

ring. 

 Outer fade ramp : Float value between 0.01 and 1.5, Alpha ramp on the outside of 

the ring. 

Clouds  

 Have clouds : On/Off value, Rendering of the clouds. 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 

 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Inverted : On/Off value, Invert the noise result (valleys <-> mountains). 

 Covering : Float value between 0 and 1, Coverage of the clouds. 



 Smoothness : Float value between 0 and 0.3, Edge smoothness of the clouds. 

 Coriolis spread : Float value between 0 and 5, Distribution of the Coriolis effect 

 Coriolis intensity : Float value between -2.5 and 2.5, Intensity of the Coriolis effect. 

 Details : Float value between 0 and 5, Extra details added on the edges of the clouds. 

 Scale : Float value between 0.1 and 10, Scale of the twirls in the clouds. 

 Roughness : Float value between 0 and 1, Roughness of the twirls in the clouds. 

 Vertical scale : Float value between 0.1 and 10, Vertical scale of the twirls. 

 Intensity : Float value between -2.5 and 2.5, Intensity of the twirls. 

 Density : Float value between 0 and 1, Coverage of the twirls. 

 Color bias : Float value between -0.6 and 0.6, Cloud color ramp bias. 

Cities  

 Have cities : On/Off value, Rendering of the cities. 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Lights scale : Float value between 1 and 100, Cities scale. 

 Lights limit : Float value between 0 and 1, Cities scale. 

 Lights sharpness : Float value between 0 and 1, Cities scale. 

 Roads scale : Float value between 0.5 and 20, Cities scale. 

 LF cities : Float value between 0 and 1, Low frequency cities. 

 MF cities : Float value between 0 and 1, Medium frequency cities. 

 HF cities : Float value between 0 and 1, High frequency cities. 

 Cities coverage : Float value between 0 and 1, Coverage of the cities. 

 Roads coverage : Float value between 0 and 1, Coverage of the roads. 

 Roads width : Float value between 0.01 and 1.5, Coverage of the roads. 

 Spread around roads : Float value between 0.05 and 0.9, Spread cities around roads. 

 Minimal altitude : Float value between -0.1 and 0.1, Minimal altitude relative to 

water level under which no city is generated. 

 Maximal altitude : Float value between 0 and 1, Maximal altitude above which no 

city is generated. 

 Minimal temperature : Float value between -1.5 and 0.5, Influence of the coast on 

cities location. 

 Maximal temperature : Float value between -0.5 and 1.5, Influence of the coast on 

cities location. 

 Coastal cities : Float value between -0.5 and 1, Influence of the coast on cities 

location. 

 Terrain modifier : Float value between 0 and 5, Affects the roads to follow the 

terrain relief. 

 Slope influence : Float value between 0 and 1, Influence of slopes on cities location. 

 AO influence : Float value between -1 and 1, Influence of AO on cities location. 

 Direct bias : Float value between -0.6 and 0.6, Direct light bias. 

 Direct intensity : Float value between 0 and 1.5, Directt light intensity. 

 Indirect bias : Float value between -0.6 and 0.6, Indeirect color ramp bias. 

 Indirect intensity : Float value between 0 and 1.5, Indirect light intensity. 



 Cities blending : Float value between 0 and 2, The alpha value of the cities in 

daylight. 

 Cities blending limit : Float value between 0 and 1, The alpha value of the cities in 

daylight. 

 Cities sharpness : Float value between 0 and 1, The alpha value of the cities in 

daylight. 

 Color bias : Float value between -0.6 and 0.6, Color ramp bias. 

Shader  

 Amplitude : Float value between 0 and 15, Displacement amplitude. 

 Tesselation : Float value between 1 and 6, Tesselation level. 

 Displacement offset : Float value between 0 and 1, Displacement reference height. 

 Water emissive : Float value between 0 and 1, Water self emit intensity. 

 Water normal intensity : Float value between 0 and 1, Intensity of the water's 

normals. 

 Indirect intensity : Float value between 0 and 3, Intensity of the envmap used for the 

lighting. 

 Global shadows : Float value between 0 and 1, Intensity of the realtime shadows on 

the ground. 

 Night lights offset : Float value between -1 and 1, Night light on offset. 

 Night lights intensity : Float value between 0.1 and 100, Night light on offset. 

 Clouds translucency : Float value between 0 and 1, Transparency level of the clouds. 

 Clouds intensity : Float value between 0 and 1, Luminosity of the clouds. 

 Clouds speed : Float value between -1 and 1, Rotation speed of the cloud texture. 

 Clouds shadows : Float value between 0 and 2, Darkness of the clouds shadows. 

 Clouds fluffyness : Float value between 0.01 and 1, Defines how fluffy the clouds are. 

 Clouds coverage : Float value between 0 and 1, Cloud coverage on the planet. 

 Clouds height : Float value between 0 and 0.15, Parallax height of the clouds. 

 Have atmosphere : On/Off value, Render atmosphere. 

 Atm inverse red : Float value between 0 and 1, Inverse wavelength for the red 

component. 

 Atm inverse green : Float value between 0 and 1, Inverse wavelength for the green 

component. 

 Atm inverse blue : Float value between 0 and 1, Inverse wavelength for the blue 

component. 

 

Backgrounds parameters  

Global  

 X translation : Float value between -20 and 20, X translation of the noise generators. 

 Y translation : Float value between -20 and 20, Y translation of the noise generators.. 

 Z translation : Float value between -20 and 20, Z translation of the noise generators.. 

 X rotation : Float value between -180 and 180, X rotation of the noise generators. 



 Y rotation : Float value between -180 and 180, Y rotation of the noise generators.. 

 Z rotation : Float value between -180 and 180, Z rotation of the noise generators.. 

 X scale : Float value between 0.5 and 2, X scaling of the noise generators. 

 Y scale : Float value between 0.5 and 2, Y scaling of the noise generators.. 

 Z scale : Float value between 0.5 and 2, Z scaling of the noise generators.. 

Nebulae  

 Use layer : On/Off value, Activate or not the nebulae rendering. 

 Noise source : Integer value between 0 and 4, Noise generator source. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between 0 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between 0 and 2, Medium frequencies intensity. 

 High frequencies : Float value between 0 and 2, High frequencies intensity. 

 Distortion : Float value between -8 and 8, Noise distortion. 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Octaves : Float value between 1 and 12, Number of octaves used to generate the 

noise. 

 Substeps : Float value between 1 and 4, Number of substeps to improve visual 

quality. This may affect the rendering time and responsiveness of the software. 

 Main color : Color ramp with ramp shape control, Background of the nebulae. 

 Color range : Range of values, Define the min and max value of the color range of the 

background. 

 Color range tuning : Float value between -0.03 and 0.03, Adjustment of the ramp. 

 Density : Float value between 0 and 10, Intensity of layer. 

 Alpha attenuation : Float value between 0 and 1, Intensity of layer. 

 Depth : Float value between 0 and 4, Depth of layer. 

 Intensity : Float value between 0.01 and 10, Intensity of layer. 

Lighting  

 Lighting color : Color ramp with ramp shape control, Color of the light used to lit the 

nebulae. 

 Lighting bias : Float value between -0.6 and 0.6, Cloud color ramp bias. 

 Lighting range : Range of values, Define the min and max value of highlight range. 

 Highlighting position : Integer value between 0 and 3, Highlight position in the color 

ramp. 

 Highlighting distribution : Float value between 0.01 and 20, Nebulae highlight 

distribution. 

 Highlighting intensity : Float value between 0 and 100, Nebulae highlight intensity. 

 Directionnal lighting : On/Off value, Light the nebulae using a direction. 

 Z direction : Float value between -1 and 1, Intensity Z direction for light. 

 XY Orientation : Float value between -3.1416 and 3.1416, Light orientation. 

 Lighting contrast : Float value between 0.1 and 5, Lighting ramp contrast. 

 Local lighting : Float value between 0.01 and 0.25, Local lighting. 



Stars  

 Stars seed : Float value between 0 and 1, Random seed used to generate stars 

parameters 

 Stars density : Float value between 0 and 0.5, Density of the stars 

 Stars intensity : Float value between 0 and 100, Brightness intensity of the stars 

 Stars size : Float value between 0 and 2, Size of the stars. 

 Bright stars ratio : Float value between 0 and 5, Chance of have super bright stars in 

the sky dome. 

 Bright stars boost : Float value between 0.15 and 5, Boost level of bright stars, high 

values increases their brightness. 

 Noise type : Integer value between 0 and 24, Noise generator type. 

 Roughness : Float value between 0.05 and 0.8, Noise roughness. 

 Low frequencies : Float value between -1 and 2, Low frequencies intensity. 

 Medium frequencies : Float value between -1 and 2, Medium frequencies intensity. 

 High frequencies : Float value between -1 and 2, High frequencies intensity. 

 Distortion : Float value between -2 and 2, Noise distortion. 

 Ramp : Float value between 0 and 1, Noise ramp (not used on every noise types). 

 Seed : Float value between 0 and 1, Seed used for random generation. 

 Scale : Float value between 0 and 50, Noise scale. 

 Vertical scale : Float value between 0 and 50, Noise vertical scale. 

 Octaves : Float value between 1 and 21, Number of octaves used to generate the 

noise. 

 Inverted : On/Off value, Invert the noise result (valleys <-> mountains). 

 mask intensity : Float value between -2 and 2, Intensity of the mask 

 nebulae stars spread : Float value between -1 and 1, Use a positive value to have 

more stars in the nebulae, use a negative value to have less stars in the nebulae. 

 nebulae stars density : Float value between 0 and 1, Use a positive value to have 

more stars in the nebulae, use a negative value to have less stars in the nebulae. 

 Colors : Separator, Color range of the stars 

 Stars nebula coloring : Float value between 0 and 1, Stars recoloring. 

 Nebulae border : Float value between 0 and 3, Thickness of the nebulae uncolored 

border. 

 Randomized coloring : Float value between 0 and 1, Randomization level of coloring 

Sun  

 Sun scale : Float value between 0.05 and 2, Size of the sun 

 Sun glow intensity : Float value between 0 and 5, Intensity of the sun 

 Sun hue : Float value between 0 and 1, Hue of the color of the sun 

 Sun saturation : Float value between 0 and 1, Saturation of the color of the sun 

 Sun light intensity : Float value between 0.5 and 6, Light intensity of the sun 

 Flares presets : Integer value between 0 and 10, Flare model placed at sun position 

 Flares intensity : Float value between 0.01 and 1.5, Intensity of the flare. 



 

 

Post effects parameters  

Post effect  

 Activate post effects : On/Off value, Rendering of post effect layer. 

 Bloom intensity : Float value between 0 and 0.4, Intensity of the bloom effect 

 Lens dirt : Float value between 0 and 0.95, Intensity of the lens dirt effect 

 Sharpening intensity : Float value between 0 and 1, Intensity of unsharp mask effect 

 Sharpening radius : Float value between 0.5 and 3, Radius of unsharp mask effect 

 Vignetting intensity : Float value between 0 and 5, Intensity of the vignetting. 

 Vignetting blur : Float value between 0 and 1, Blur level on the corner of the screen. 

 Chromatic aberration : Float value between -5 and 5, Chromatic aberrations level. 

Material  

o Activate shadows : On/Off value, Render shadows in the viewport. 

 

 

 

 

 

  



F.A.Q. 
 

Q. I'm getting a fatal error right after the main screen opens saying "Fatal Error" "Player is 

already running". 

A.Try running the application directly from steam and not from a shortcut you’ve created 

yourself. 

Q. I start it up and I see stars in the viewport but only a black spot for the planet. I do have 

Direct X 11, what’s going on? 

A. If you have a laptop, check also that you are using the correct graphic card, not the low-

end integrated one (often an intel one) ... If your main graphic card is an nvidia, you can 

change that by choosing Nvidia Control Panel in the desktop menu (Right mouse button), 

than go to Manage 3D settings and select the NVidia processor in the ‘Preferred graphics 

processor’, than retry the application. In the latest version (1.0.5 and up) of GD, there is a 

warning if you try to run the application with an intel CG. 

Q.  Is there any tutorials available? 

A.  Yes, there is a playlist available. Launch the software and go to Help->Online tutorials. 

Q. I can’t export to resolution higher than 4k x 2k? I’ve read that GD can export to 16k x 

8k… 

A.Anything above 4k requires the PRO DLC to be available, the  basic version of the software 

is limited to 4k or less. The same goes for the snapshots, basic version can do only 1x 

snapshots, PRO DLC allows up to 8x resolution. 
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